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handsfree-växling med 
röstuppringning, och musiksamtal 
– allt i ett

• Programmet Nokia Audio Manager 
med Internet-anslutning 

• Programmet Nokia CD Manager 
(lätt att använda för vanliga 
åtgärder)

• Självförsörjande  – kan användas 
med eller utan en Nokia-
mobiltelefon

• Kompatibel med Nokia-
mobiltelefonerna 3310, 3330, 8210, 
8250, 8850 och 8890. (Se bilderna.)

Framsida



 Mobile Phones.
Med ensamrätt.

AYER 

m helst form, 

- och 

odukter som 

r indirekt skada, 

tning, ges inga 
avseende 
dra detta 

 begära tillstånd 
ovsrättsskyddat 
2

Konfor

Vi, NOK
uppfyller

Copyrigh

Reproduk
utan skrif

Nokia oc
företagsn

Nokia utv
beskrivs 

Under ing
oavsett o

Innehålle
garantier
produkte
dokumen

Musik är
eller licen
material.

Tillgång 
© 2001 Nokia

mitetsdeklaration

IA MOBILE PHONES Ltd, tillkännager under vårt ensamma ansvar att produkten NOKIA MUSIC PL
 villkoren i följande EU-direktiv: 1999/5/EC.

t © Nokia Mobile Phones 2001. Med ensamrätt.

tion, överföring, distribution eller lagring av delar av eller hela innehållet i detta dokument i vilken so
tlig tillåtelse från Nokia är förbjuden.

h Nokia Connecting People är registrerade varumärken som tillhör Nokia Corporation. Andra produkt
amn som det hänvisats till kan vara varumärken eller varunamn som tillhör sina respektive ägare.
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 igenom dessa enkla regler. Att bryta mot reglerna kan vara farligt eller olagligt. Me
rmation finns i den här handboken.

i telefonens användarhandbok för att få instruktioner om hur telefonen fungerar, info
tsel och underhåll samt viktig säkerhetsinformation.

Trafiksäkerheten kommer i första hand

Du kan ansluta din Nokia-mobiltelefon till Nokia Music Player men inte använ
medan du kör. Parkera fordonet först.

Störningar

Alla mobiltelefoner kan drabbas av störningar som påverkar prestandan.

Stäng av på sjukhus

Följ alla föreskrifter och regler. Om du har anslutit din Nokia-mobiltelefon till 
Player ska du stänga av telefonen när du befinner dig i närheten av medicinsk u

Stäng av i flygplan

Mobiltelefoner kan orsaka störningar. Stäng av Nokia Music Player och Nokia-
mobiltelefonen när du flyger. Det är olagligt att använda dem i flygplan.

Stäng av när du fyller på bensin

Använd inte telefonen vid bensinstationer. Använd den inte nära bränsle och ke

Stäng av vid sprängning

Använd inte telefon eller radio där sprängning pågår. Lägg märke till restriktio
alla föreskrifter och regler.
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Använd kvalificerad service

Låt endast därtill kvalificerad  servicepersonal installera eller reparera utrustnin

Tillbehör och batterier

Använd bara godkända tillbehör och batterier. Anslut inte inkompatibla produk

Ansluta till andra enheter

Innan du ansluter telefonen till någon annan enhet bör du läsa säkerhetsinstrukt
enhetens användarhandbok. Anslut inte inkompatibla produkter. Kom ihåg att g
säkerhetskopior av alla viktiga data.

Volym

Njut av din musik men spela inte med för hög volym. Höga ljudnivåer kan ska
Var försiktig när du väljer lyssningsvolym.

Hörlurar och nackrem

Använd inte hörlurarna eller nackremmen där det inte är säkert att göra det.
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ns tre olika sätt att använda Nokia Music Player. 

ende spelare
 kan använda Nokia Music Player för sig själv som en liten, portabel och högkvalita
spelningsenhet. Mer information om hur du använder Nokia Music Player som en f
lare finns i Nokia Music Player – Spela upp från minneskort.

ten till Nokia-mobiltelefon
 Nokia Music Player är ansluten till din Nokia-mobiltelefon kan du använda telefon

 kan ta emot och ringa samtal utan att röra mobiltelefonen. Mer information om hur 
kia Music Player med din Nokia-mobiltelefon finns i Nokia Music Player – Använda s
dsfree-headset.
bs: Eftersom du använder samma kabelport för både Nokia-mobiltelefonen o

kan du inte ansluta båda enheterna samtidigt.

ten till en kompatibel dator
kia Music Player tar emot nya musikfiler från din dator. Filerna överförs direkt till m
kia Music Player. Mer information om hur du använder Nokia Music Player när den
datorn finns i Nokia Audio Manager – Användning eller Nokia CD Manager.
bs: Använd inte denna produkt på något sätt som kan kränka eventuella 

upphovsrättigheter som gäller för den musik du hämtar eller kopierar.

Licensen är systemspecifik. Om du planerar att använda programmet på f
datorer, måste det registreras på varje dator.
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 måste välja mellan två olika program för att hantera din musik. 

 CD Manager
d Nokia CD Manager kan du kopiera musik från en cd-skiva, byta namn på musiksp
rföra musiken till Nokia Music Player. Du behöver inte någon Internet-anslutning. 

t att använda
d-läshantering
nkel överföring till Nokia Music Player 
ndast AAC 64 kbps kan hanteras (64 kbps är en timme på ett minneskort med 32MB

 Audio Manager
kia Audio Manager är en komplett musikhanterare som du kan använda för att kopie
skivor (läsning), hämta musik från Internet, skapa en databas med din musik och öv
kia Music Player. Du måste vara ansluten till Internet för att komma åt cd-databasen
dio Manager. 

vudfunktioner
d-läsare (AAC)
atabashantering (flera format: MP3, AAC, etc.) inklusive äldre MP3-filer
verföring till Nokia Music Player
nternet-anslutning (för att hämta musik)
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 CD Manager

tallera Nokia CD Manager

t i cd-romskivan i datorn. Börja installationen genom att välja ikon på huvudmenyn.
 någon Internet-anslutning.

bs: Anslut inte Nokia Music Player till datorn förrän du har installerat Nokia
Manager.

Innan du kan ansluta musikspelaren går du till Komma igång för att lära d
• installerar batteriet
• kopplar in hörlurssladden
• sätter i minneskortet

sluta Nokia Music Player

ppla USB-kabeln till telefon/dator-kontakten och USB-porten på datorn.

 på Nokia Music Player

ut knappen audio/off till audio. 

rta Nokia CD Manager

j Nokia CD Manager på Start-menyn.

ta i en musik-cd

t i en cd-skiva med musik i datorn.

lja spår

cka på titlarna för att välja de spår som ska överföras till datorn.
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Överföra spår från cd-skivan

Klicka på Read a CD för att överföra valda spår till datorn.

Byta namn på spår

Högerklicka på ett spår. Ange en titel eller ändra namnet.

Spara spår med nya namn

Klicka på Rename så stängs rutan och titeln sparas med det nya namnet.

Kopiera till Nokia Music Player

Välj de spår i fönstret vänstra sida som ska överföras till Nokia Music Player. Klicka på
spår överförs till Nokia Music Player.

ia Audio Manager

Installera Nokia Audio Manager

Sätt i cd-romskivan i datorn. Börja installationen genom att välja ikon på huvudmenyn.

Obs: Innan du kan ansluta musikspelaren går du till Komma igång för att lära d
• installerar batteriet
• kopplar in hörlurssladden
• sätter i minneskortet

Ansluta Nokia Music Player

Koppla USB-kabeln till telefon/dator-kontakten och USB-porten på datorn.
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Slå på Nokia Music Player

Skjut knappen audio/off till audio. 

Starta Nokia Audio Manager

Välj Nokia Audio Manager på Start-menyn.

Sätta i en musik-cd

Sätt i en cd-skiva med musik i datorn.

Överföra spår från cd-skivan

Klicka på make a playlist och sedan read a CD.

Hämta spårtitlar från cd-databasen

Om inga spårtitlar har spelats in på cd-skivan, frågar Nokia Audio Manager om du vill 
spårtitlarna från cd-databasen på Internet. Klicka på Yes. Du behöver en Internet-anslut

Välja spår

Klicka i rutan bredvid de spår som du vill kopiera till musikdatabasen.

Börja läsa in spår

Klicka på Start Reading. När alla valda spår har kopierats visas Recording completed su
Spåren har lagts till i databasen med musikspår.

Välja spår från databasen

Klicka på Select Tracks From Database. 

Välja spår för spelningslista

Klicka i rutan bredvid de spår som du vill kopiera för att lägga till dem i spelningslistan
sedan på OK.
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Spara valda spår i en spelningslista

Klicka på Save Tracks as Playlist och ange ett namn för spelningslistan. Klicka på Close

Kopiera till Nokia Music Player

Klicka på copy to devices.

Välja spår eller spelningslistor som ska kopieras till Nokia Music Player

Klicka på Select Tracks From Database eller Select Playlists From Database, klicka i ruta
spår eller spelningslistor som du vill kopiera till Nokia Music Player och klicka sedan p

Kopiera till Nokia Music Player

Kontrollera att Nokia Music Player är påslagen. Klicka på Copy To Portable. Sending to 
förloppsindikator visas. När kopieringen är färdig visas Finished transferring tracks. Kli

ia Music Player

Slå på musikspelaren (standby-läge)

Skjut knappen audio/off till audio. 

Börja uppspelning

Tryck på .

Justera volymen

Tryck volymknappen uppåt + eller nedåt –.

Pausa uppspelning

Tryck på  medan ett spår spelas upp.



��

17  Mobile Phones.
Med ensamrätt.

r att gå 

.

FM
	%%������������

© 2001 Nokia

Fortsätta uppspelning

Tryck på  när ett spår är pausat.

Välja spår

Tryck snabbt en gång på  för att gå till nästa spår. Tryck snabbt två gånger på  fö
tillbaka till föregående spår.

Snabbspola

Tryck och håll ner  eller . När du släpper  eller  börjar uppspelningen igen

-radio

Slå på musikspelaren

Skjut knappen audio/off till audio. 

Välja uppspelning från FM-radion

Tryck och håll ner mode i några sekunder tills  visas.

Välja frekvens

Tryck på  eller  tills du kommer till önskad frekvens.

Justera volymen

Tryck volymknappen uppåt + eller nedåt –.

FM
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dsfree-headset
Innan du kan börja använda musikspelaren som ett handsfree-headset måste du ansluta 
Player till mobiltelefonen. Se Ansluta Nokia Music Player till telefonen.

Ta emot ett samtal

Tryck på  i en sekund.

Ringa ett samtal (endast Nokia-mobiltelefoner 3310 och 8890)

1. Tryck och håll ner  tills rösttonen hörs i telefonen.

2. Tala in namnet på numret som är inspelat på telefonen.

Avsluta ett samtal

Tryck på .
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ation
e minimikrav gäller för att kunna installera Nokia Audio Manager:

bs: Om du inte har någon Internet-anslutning går du till Installera Nokia CD M
Anslut inte Nokia Music Player till datorn förrän du har installerat anting
Audio Manager eller Nokia CD Manager.

tar installationen genom att klicka på knappen Install the Nokia Audio Manager i
tionsprogrammet för Nokia Music Player som finns på cd-romskivan.

ta i cd-romskivan i datorn

luta alla aktiva program och sätt sedan i cd-romskivan som medföljer Nokia Music 
orn. Mer information finns i användarhandboken för datorn. När du väljer installation
udmenyn installeras Nokia Audio Manager automatiskt. Följ anvisningarna på skär
föra installationen.

ekt Krav
r IBM PC/AT-kompatibel.

essor Pentium MMX 266 MHz krävs. Pentium 300 MHz rekommender

ne Minst 48 MB rekommenderas. 64 MB föreslås för Windows 2000

ddisk 35 MB ledigt diskutrymme krävs för att installera programvaran. 
ytterligare utrymme för dina musikfiler.
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allera Nokia Audio Manager

tomatisk avinstallation av Nokia Audio Manager (från Start-menyn)

j Start > Program > Nokia > Nokia Audio Manager > Uninstall Nokia Audio Manager.

igenom dialogrutorna för att avinstallera Nokia Audio Manager.
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ation
tar installationen genom att klicka på knappen Install the Nokia CD Manager i 
tionsprogrammet för Nokia Music Player som finns på cd-romskivan.

ta i cd-romskivan i datorn

luta alla aktiva program och sätt sedan i cd-romskivan som medföljer Nokia Music 
orn. Nokia CD Manager installeras automatiskt på hårddisken när du väljer installati
kärmen Install Nokia Audio Manager. Följ anvisningarna på skärmen för att slutför
allationen.

bs: Anslut inte Nokia Music Player till datorn förrän du har installerat Nokia
Manager.
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Målkatalogen för programfilerna är C:\Program\Nokia\CD Manager. Klicka på Next> för 
Det rekommenderas att du använder denna katalog eftersom det finns länkar till körbar
katalogen.
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Installationen är färdig. Klicka på Close.
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allera Nokia CD Manager

tomatisk avinstallation av Nokia CD Manager (från Start-menyn)

 installationen av CD Manager misslyckas klickar du på Cancel. 
j Start > Program > Nokia > Nokia CD Manager > Remove Nokia CD Manager.

igenom dialogrutorna för att avinstallera Nokia CD Manager. När Nokia CD Manag
nstallerats kan du försöka att installera igen genom att klicka på knappen Install the N
ager i installationsprogrammet för Nokia Music Player som finns på cd-romskivan.
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över gå igenom några snabba steg för att komma igång med Nokia Music Playe
ggrant. 

era batteriet

bort batterilocket

l Nokia Music Player med baksidan mot dig. Tryck nedåt på batterilocket (1) och dr
i samma riktning som pilarna på locket. Lyft försiktigt upp batterilocket för att öppn
terifacket (3).

1

2 3



��

26  Mobile Phones.
Med ensamrätt.

tryck och 
s (2) för att 
��	���������	 �����'���	������

© 2001 Nokia

Sätta i batteriet

Sätt i batteriet med plusänden + först i batterifacket. 

Stänga batterilocket

Vik ner batterilocket (1) och 
skjut försiktigt locket på plat
stänga batterifacket.

1

2

1

2
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Koppla in hörlurssladden
Koppla in hörlurssladden på höger sida av Nokia Music Playe

Obs: Var alltid försiktig när du kopplar in eller ur slad
tag i den tjockare delen av sladden, strax ovanfö
metallkontakten. Koppla aldrig in eller ur sladde
att hålla eller dra i själva sladden.

ta i minneskortet

Öppna luckan till minnesko

Ta tag i undersidan av Nokia 
och öppna minneskortslucka
dra från skåran.
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Sätta i minneskortet

Vänd Nokia Music Player med framsidan nedåt och håll upp minneskortsluckan. Rikta 
av minneskortet uppåt, stoppa in kortet i uttaget och tryck till. Minneskortet låses på pla

Obs: Du ska alltid se till att Nokia Music Player är avstängd innan du installer
minneskortet.
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Stänga luckan till minneskortet

Lyft upp och stoppa in fliken på minneskortsluckan i kortuttaget.

Obs: Om minneskortet inte är ordentligt isatt går det inte att stänga luckan. Ta 
minneskortet (se nedan) och försök igen.

r minneskortet

Öppna luckan till minneskortet

Ta tag i undersidan av Nokia Music Player och öppna minneskortsluckan genom att dra
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Ta ur minneskortet

Tryck in minneskortet (1). När det trycks in hela vägen frigörs det (2). Dra ut och ta bo
minneskortet från Nokia Music Player.

Obs: Du ska inte ta ur minneskortet medan strömmen till Nokia Music Player 
påslagen. Då kan du förlora musik som spelats in i minnet eller skada 
minneskortet.

1 2
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a Nokia Music Player

Ta på dig hörlurarna

Den vänstra hörluren är märkt med ett L. Stoppa denna hörlur i det vänstra örat. Den län
hörlursladden är den högra kanalen. Lägg sladden för den högra kanalen runt nacken oc
öra.
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Bära Nokia Music Player

Nokia Music Player har en klämma på baksidan som gör att du kan sätta fast eller häng
kläder av olika tjocklek. Du kan hänga spelaren i överkanten av en ficka, i kragen till en
en jacka, nästan var som helst. 
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Dra hörlurssladden igenom nackremmen

Dra hörlurssladden genom den Nokia-märkta sladdhållaren innan 
hörlurssladden i Nokia Music Player. 

Sätta fast remmen i Nokia Music Player

Trä den läderliknande remmen igenom öglan som finns på baksida
Music Player.
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Ta på dig nackremmen

Ta nackremmen över huvudet så att Nokia Music Player hänger runt nacken.

Obs: Hörlurssladden fungerar som en FM-radioantenn. Genom att använda 
nackremmen undviker du att hörlurssladden virar in sig och du får bättre 
radiomottagning. 
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bs: Du måste installera Nokia Audio Manager eller Nokia CD Manager inna
ansluter Nokia Music Player till datorn. 

Ta bort locket till telefon/dator-kontakten

Dra upp locket på telefon/dator-kontakten. Locket kan tas bort från
dator-kontakten men förblir ansluten till Nokia Music Player.

Obs: För att undvika att damm, smuts eller fukt kommer i
telefon/dator-kontakten på Nokia Music Player ska d
sätta tillbaka locket när du inte använder spelaren.

Ansluta Nokia Music Player

Koppla in USB-kabeln i telefon/dator-kontakten. Se till att pinnarn
riktade. 

bs: Var alltid försiktig när du kopplar in eller ur sladden. Ta tag i den tjockare
sladden, strax ovanför metallkontakten. Koppla aldrig in eller ur sladden g
hålla eller dra i själva sladden.

�
��
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Ansluta till en kompatibel dator

Koppla in USB-kabeln i USB-uttaget på en kompatibel dator. Mer information finns i 
användarhandboken för datorn. 

Obs: När du ansluter Nokia Music Player ska den vara i standby-läge. Skjut au
knappen till off och sedan till audio igen. Detta är standby-läge.

Obs: Koppla ur Nokia Music Player från datorn och stäng av den om du inte tä
använda spelaren under en längre period.

Slå på musikspelaren

Skjut knappen audio/off till audio. 

Obs: Om du inte har satt i något minneskort eller om det inte är o
isatt visas . Om minneskortet är tomt visas 

Om spelaren inte används på tre minuter ställs den i viloläg
displayen släcks. Tryck på  när du vill aktivera spelare

No Media
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ra din musik
kia Music Player är ansluten till din dator och du använder det medföljande pro
udio Manager kan du göra följande:

piera musik från ditt eget cd-bibliotek

 kan kopiera innehållet i ditt eget bibliotek över cd-skivor, överföra det till minnesko
ända det i Nokia Music Player.

mta musik från Internet

 kan hämta särskilt kodade musikfiler från Internet och överföra dem till din dator el
neskort för uppspelning.

dna ditt musikbibliotek

 kan skapa spelningslistor med din favoritmusik. Dessa spelningslistor kan du sedan
ammans med musiken till Nokia Music Player. Du kan också skapa bibliotek med o
siksamlingar.

bs: Efter installationen behöver du bara en Internet-anslutning när du hämtar
spårtitlar från cd-databasen (Compact Disc DataBase) på Internet.

MP3-filer som skapats för Nokia Music Player är krypterade och kan inte 
andra musikspelare.

För att skydda upphovsrättigheter är innehållet som kan hämtas till enhet
begränsat. Se Nokia Audio Manager – Filtyper.
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ta Nokia Audio Manager

Starta Nokia Audio Manager

Välj ikonen Nokia Audio Manager  på Start-menyn. Programmet laddas och startskä
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Nokia Audio Manager försöker ansluta till din Nokia Music Player. Looking for hardwar
på datorskärmen. 

Om Nokia-musikspelaren är påslagen och korrekt ansluten, rullas  över dis
Nokia Music Player.

Obs: Medan Nokia Music Player är ansluten till datorn och  visas 
inte använda kontrollerna på Nokia Music Player för att lyssna på musik.

Om Nokia Music Player är avstängd eller om telefon/dator-sladden inte ä
ordentligt ansluten, visas Unable to communicate with portable device på 
datorskärmen. Följ anvisningarna som visas och se i Nokia Audio Manage
Felmeddelanden i denna handbok.

PC connected

PC connected
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tkommandon på datorn
a kommandon och menyval kan du göra genom att trycka på en tangent eller en kom
enter utan att flytta markören. I detta avsnitt anges kommandot eller menyvalet i fe
en som är kortkommando som understruket.

Välja en meny

Tryck på ALT-tangenten och kortkommandot. Om menyn som ska öppnas är File, trycke
och F samtidigt. Menyn File öppnas.

Välja ett alternativ i en öppen meny

Tryck på kortkommandot. Om menyn Help är öppen och du vill öppna Help Topics, tryc
Då visas fönstret Help Topics.

Välja en knapp

Tryck på kortkommandot. Om knappen är Select Tracks From Database, trycker du på T
Select Tracks From Database öppnas.
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lp – Vad är nästa åtgärd?
 dessa instruktioner noggrant och om du behöver hjälp medan du befinner dig i No
ager kan du klicka på knappen Help "?" i det övre högra hörnet för att öppna direk
edan kan välja ett avsnitt. Om du är osäker på en viss åtgärd väljer du Help Topics 
 högst upp till vänster och söker efter hjälp om åtgärden i fråga. Hjälpfilerna inneh
ljerade anvisningar för alla åtgärder som du kan utföra med Nokia Audio Manager,
rder som inte beskrivs i denna handbok.

Obs: Det rekommenderas att du går igenom direkthjälpen efter installationen.

Help “?
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en cd-skiva

rta Nokia Audio Manager

ta i cd-skivan

r information om hur du sätter i en cd-skiva finns i anvisningarna som medföljer dat

bs: Om den cd-skiva du sätter i inte har några spårtitlar inspelade visas följan
varningsmeddelande.

Tryck på Yes. Information om spelningslistan hämtas från cd-databasen på
och visas på skärmen.

Du måste ha en Internet-anslutning för att visa denna information från cd
databasen.
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Överföra spår från cd-skivan

Klicka på make a playlist och klicka sedan på Get Tracks From CD. 

Om det redan finns spår i spelningslistan när du klickar på Get Tracks From CD visas en
med följande alternativ: Play this CD, Append to Playlist, Cancel. Om du klickar på Play t
spåren i listan med spåren på cd-skivan. Om du väljer Append to Playlist, läggs spåren fr
till i spelningslistan.
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Välja ett spår

Du väljer det spår du vill spela genom att placera markören över önskat spår och klicka
grön ruta visas till vänster om det valda spåret och spåret markeras. Information om val
den högra fönsterrutan.
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Spela ett spår

Tryck på . Det valda spåret börjar spelas upp och den gröna rutan ändras till en grö
visar att spåret spelas. Om tillgängligt, rullas spårets namn, längd och artist över display
i fönstret. 

Obs: Ett ljudkort krävs för att höra uppspelningen. Se Specifikationer.

Välja ett annat spår

Om du vill byta spår, väljer du ett annat spår och trycker på . Det valda spåret börj

Spola igenom ett spår

Medan du spelar ett spår kan du placera markören över knappen SCAN, hålla ner vänste
och dra knappen SCAN till ett annat ställe i spåret. Uppspelningen fortsätter även under

Upprepa cd-uppspelning

Klicka på REPT. Indikatorn REPT blir grön och när alla spår på cd-skivan har spelats, bö
uppspelningen igen från det första spåret. När du vill avbryta upprepning klickar du på 

Slumpmässig uppspelning

Klicka på SHUF. Indikatorn SHUF blir grön och spåren på cd-skivan spelas upp i slumpv
När du vill avbryta slumpmässig uppspelning klickar du på SHUF igen.

SCAN REPT SHUF
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ända liten spelare

Växla till liten spelare

Klicka på  längst ner till höger i fönstret för att ändra Nokia Audio Manager till en

Med den lilla spelaren kan du spela upp spåren i aktuell spelningslista. När du vill återgå
spelaren högerklickar du på den lilla spelaren och väljer Big Player. 

SCAN Spela SHUF REPT
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 till spår från cd-skivor
 Audio Manager kan du spela in spår från dina cd-skivor. Spåren spelas in som
r och lagras på hårddisken. 

ta i cd-skivan

r information om hur du sätter i en cd-skiva finns i anvisningarna som medföljer dat

bs: Om du sätter i en cd-skiva medan Nokia Audio Manager är öppet läggs s
cd-skivan till automatiskt i spelningslistan.

Om den cd-skiva du sätter i inte har några spårtitlar inspelade visas följan
varningsmeddelande.

Tryck på Yes. Information om spelningslistan hämtas från cd-databasen på
och visas på skärmen.

Du måste ha en Internet-anslutning för att visa denna information från cd
databasen.

erföra spår från cd-skivan

cka på read a CD.
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Välja ett spår

Klicka i rutan bredvid det spår som du vill ha. En bockmarkering visas i rutan.

Avmarkera ett spår

Klicka på bockmarkeringen bredvid det spår som du vill avmarkera.

Välja alla spår

Klicka på Tag All. 

Avmarkera alla spå

Klicka på Untag All. 

a/avmarkera

Tag All Untag All
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Börja läsa in spår

Klicka på Start Reading. Nokia Audio Manager börjar koda och kopiera valda spår till h
Åtgärdens status visas i förloppsindikatorn längst ner till höger i fönstret. När ett spår h
kopierats till hårddisken försvinner bockmarkeringen och ikonen ändras från  till 
valda spår har kodats och kopierats till hårddisken visas Recording completed successfu
skärmen. Klicka på OK. Nokia Audio Manager har nu skapat en spelningslista i din data
aktuell cd-skiva och länkat de nya spåren till den spelningslistan.

Start Reading
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Redigera spårinfo

I fönstret read a cd, klicka på Edit Track Info. Fönstret Review Playlist öppnas och spåren
Välj det spår du vill redigera genom att klicka på det. Klicka på Review/Edit. Redigera b
information eller lägg till information för varje spår. Tryck på <<Prev eller Next>> för at
föregående respektive nästa spår. Tryck på Close för att spara dina ändringar och stänga
tryck på Cancel om du vill stänga fönstret utan att spara några ändringar.
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 till spår från Internet
iden kanske du kan hämta digitala ljudfiler från Internet. Nokia Audio Manager
era dessa filer när de läggs till på hårddisken och automatiskt lägga till dem i di

sluta till Internet

cka på club.nokia.com. Nokia Audio Manager använder din Internet-anslutning för a
b Nokia. 

bs: Om detta är första gången du besöker Club Nokia ska du registrera dig. K
Join Club Nokia. Följ anvisningarna för att registrera. Tillgänglighet kan 
mellan länder.

Obs: Om du inte har någon
Internet-anslutning sk
klicka på länken för a
club.nokia.com. Din 
kanske hänger upp si
du måste starta om.

http://www.club.nokia.com/
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a filer som kan hämtas

amtiden kommer Nokia Club att erbjuda filer för hämtning (vissa av dem kan vara g
ra kan köpas) från flera olika partners. Följ länkarna till de olika webbplatserna för 
r. Om du känner till webbadressen till en viss plats som du vill besöka, skriver du in
essfältet och klickar på Retur-tangenten på tangentbordet. Kontrollerna i detta fönste
ward, Stop och Home) fungerar precis som i din webbläsare.

mta filer

 du vill hämta en fil från Internet klickar du vanligtvis på länken till den filen. Ange
ra filen på hårddisken, så hämtas den av webbläsaren. Hämtade filer läggs automatis
abas. Mer information om hur du hämtar filer från Internet finns i dokumentationen 
bläsare.
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pa en egen spelningslista
du har dina spår i databasen kan du välja olika spår och skapa egna spelningslistor
pelvis skapa en spelningslista när du vill göra en partymix, eller skapa och skicka

ningslistor till din Nokia Music Player. Lägg till de spår som du vill ha i aktuell sp
era spåren i den ordning du vill ha dem och spara listan som en spelningslista.

Välja spår från databasen

Klicka på make a playlist och sedan på Select Tracks From Database. Fönstret Select Tra
Database öppnas med en lista över alla spår i databasen, inklusive spårens titel, artist, 
uppspelningstid, betyg och genre. Du kan sortera listan över spår genom att klicka på n
kolumnrubrikerna. Du kan exempelvis klicka på kolumnrubriken Artist om du vill sorte
alfabetiskt efter artist.
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Välja spår att lägga till i spelningslistan

Klicka i rutan bredvid det spår du vill ha. En bockmarkering visas i rutan. Du kan också 
All för att välja alla spår som visas eller Untag All om du vill avmarkera alla spår. När du
spår som du vill lägga till klickar du på OK.

Spara en egen spelningslista

Klicka på Save Tracks as Playlist. 

Fönstret Add Playlist visas. Ge spelningslistan ett namn och ange eventuell annan inform
vill lägga till genom att antingen skriva in informationen eller genom att klicka på listru
har angett all information klickar du på Close för att spara spelningslistan eller 
Cancel om du vill stänga fönstret utan att spara några ändringar. Om du klickar på Close
playlist has been saved. Klicka på OK.

Save Tracks as Playlist

Close Cancel OK
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 använda Nokia Audio Manager för att överföra spår och spelningslistor till No
 

pna fönstret med enheter

cka på copy to devices.

ga till spår

cka på Select Tracks From Database eller Select Playlists From Database för att välja 
r eller spelningslistor.

copy to devices

Select Tracks From Database Select Playlists From Database
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Välja spår som ska överföras

Klicka i rutan bredvid det spår eller den spelningslista du vill ha. Om du vill välja alla s
klickar du på knappen Tag All. Om du vill avmarkera alla valda spår klickar du på knapp
När du har valt de spår eller spelningslistor som du vill lägga till i överföringslistan klic

Obs: Om antalet spår eller spelningslistor överskrider minneskortets kapacitet 
meddelandet Not enough room. Följ anvisningarna i fönstret för att avmar
eller spelningslistor tills det finns tillräckligt med utrymme på minneskor

Tag All Untag All

OK
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Kopiera valda spår till minneskortet

Klicka på Copy to Portable. Converting file for download visas och sedan Sending to dev
förloppsfönster. När överföringen är färdig visas Finished transferring tracks. Klicka på

Ta bort spår från minneskortet

Du kan ta bort spår från minneskortet genom att välja ett spår och klicka på  eller hö
ett spår och välja Remove. Spåret tas då bort från minneskortet. 

Copy to Portable
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na funktion kommer att erbjudas vid ett senare tillfälle. Mer information finns på cl

http://www.club.nokia.com/
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okia CD Manager kan du kopiera musik från en cd-skiva, byta namn på spåren o
n till Nokia Music Player. Du behöver ingen Internet-anslutning för Nokia CD 

 och lyssna på musik
d Nokia CD Manager kan du snabbt hämta och lyssna på din musik.
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– Vad är nästa åtgärd?
ssa instruktioner noggrant och om du behöver hjälp medan du befinner dig i No
er kan du högerklicka i programfönstret och välja Help för att öppna direkthjälp
an välja ett avsnitt. Hjälpfilerna innehåller detaljerade anvisningar för alla åtgä
öra med Nokia CD Manager, även många åtgärder som inte beskrivs i denna ha

bs: Det rekommenderas att du går igenom direkthjälpen efter installationen.
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Dubbelklicka först på en bokikon i den vänstra fönsterrutan för att öppna listan över hjä
Klicka sedan på ett avsnitt så visas hjälpinformation i den högra fönsterrutan.
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Klicka på någon av knapparna i den högra fönsterrutan så visas en ruta med informatio
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. Hämta musik
j ikonen Nokia CD Manager på Start-menyn. Följande fönster öppnas:

ljudfiler som finns på datorn visas till vänster; medan ljudfilerna på din egen enhet v
er. Om din enhet inte är ansluten till datorn speglas detta i kolumnen till höger.
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 2. Läsa in en cd-skiva
Med "läsa in en cd-skiva" menas proceduren att kopiera spåren från en cd-skiva till dato
För att läsa in en cd-skiva sätter du helt enkelt i en ljud-cd i rätt enhet och startar Nokia 
Du kan välja flera intilliggande filer med hjälp av Skift-tangenten; och du kan välja fler
inte ligger intill varandra genom att använda Ctrl-tangenten. 

Klicka på knappen  för att öppna dialogrutan CD Transfer. Förloppskontro
medan åtgärden utförs.
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 3. Byta namn på spår
Högerklicka på ett filnamn i listan över spår. En redigeringsruta öppnas med namnet på
filen. 

Skriv in ett valfritt namn. Namnet måste vara unikt. Du kan inte ha flera spår med samm
datorn eller i Nokia Music Player. 

Obs: Använd inte något av följande tecken i namnet:  / \ : * ? " < > ! @ |

Klicka på Rename för att slutföra åtgärden.
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 4. Kopiera till spelaren och lyssna på musik
På vänster sida av skärmen väljer du de mediafiler som ska överföras till Nokia Music P
använda Skift-tangenten för att välja intilliggande filer, eller Ctrl-tangenten för att välja 
ligger intill varandra.

Klicka på knappen   för att kopiera filerna till Nokia Music Player.

Se Nokia Music Player – Spela upp från minneskort.
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 5. Använda menyer

erklicka i rutan Media On PC
Om du högerklickar på ett listobjekt i rutan Media On PC visas följande meny:

Change PC Directory

Audio Manager sparar som standard mediafiler på enhet C: på datorn. Om du vill ändra
högerklickar du i Nokia CD Manager och väljer Change PC Directory…

Refresh Device

Uppdaterar listan Media On PC eller Media On Device.  

Format Device

Om du vill formatera minneskortet i Nokia Music Player högerklickar du i Nokia CD M
väljer Format Device…

Obs: All musik på minneskortet i Nokia Music Player tas bort om du formater
enheten!
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Read a CD

Nokia CD Manager börjar läsa från cd-skivan.

Remove

Högerklicka på namnet på en fil om du vill ta bort den. 

Rename

Högerklicka på namnet på en fil om du vill ändra namnet. 

Help

Om du väljer Help kommer du åt direkthjälpen. 

Close

Close stänger Nokia CD Manager.
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erklicka i rutan Media On Device
När du klickar på en fil i fönsterrutan Media On Device visas följande meny:

Change PC Directory

Nokia CD Manager sparar som standard mediafiler på enhet C: på datorn.  Om du vill ä
högerklickar du i Nokia CD Manager och väljer Change PC Directory…

Refresh Device

Uppdaterar listan Media On PC eller Media On Device.  

Format Device

Om du vill formatera minneskortet i Nokia Music Player högerklickar du i Nokia CD M
väljer Format Device…

Obs: All musik på minneskortet i Nokia Music Player tas bort om du formater
enheten!

Read a CD

Nokia CD Manager börjar läsa från cd-skivan.
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Rename_track

Du kan inte ändra namnet på ett spår från rutan Media On Device.

Remove

Högerklicka på namnet på en fil om du vill ta bort den. 

Help

Om du väljer Help kommer du åt direkthjälpen.  

Close

Close stänger Nokia CD Manager.
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 6. Säkerhetskopiera och återställa musik
Denna funktion kommer att erbjudas vid ett senare tillfälle. Mer information finns på cl

http://www.club.nokia.com/
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elningskontroller för minneskortet
vsnitt beskriver de kontroller du använder för att lyssna på musik från ett minne
tion om hur du kopierar musik till minneskortet finns i Överföra musik till minn
okia Audio Manager) eller Kopiera till spelaren och lyssna på musik (med Noki

er).

Slå på musikspelaren

Skjut knappen audio/off till audio. 

Obs: Om det inte finns något minneskort i spelaren eller om det 
felaktigt isatt visas  . Om minneskortet är tomt

.

Välja uppspelning från minneskortet

Om musikspelaren användes senast för uppspelning från minneskortet vi
displayen:

 musikspelaren användes senast för uppspelning från FM-radion visas följande i dis

bs: Nokia Music Player levereras med fast programvara (firmware) version 1
Uppgradera – Nokia Music Player för instruktioner om hur och när du ska 
uppgradera den fasta programvaran (för uppgraderingar av specialfunktio
framtiden).

No Media

No Tracks

MusicOn V  1.00 Digital

MusicOn V  1.00 FM
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När du vill växla från FM-radio till uppspelning från minneskortet håll
knappen mode i flera sekunder tills  visas och sedan speln
namn. 

Obs: Om inget namn har registrerats för spelningslistan på 
minneskortet visas .

Justera volymen

Tryck volymknappen uppåt + eller nedåt – när du vill justera volymen.

Minimum

Maximum

Obs: Volymnivån sparas på Nokia Music Player. När uppspelningen återupptas
volymen till den senaste inställningen.

e

Digital

Unknown

-
+
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Spela ett spår

Tryck på . Det första spåret på minneskortet börjar spelas upp, spårets titel rullas i 
och sedan visas uppspelningstiden. 

Pausa uppspelning

Medan ett spår spelas kan du trycka på  för att pausa uppspelningen (uppspelnings
musiknoter blinkar). 

Obs: Om du lämnar spelaren i pausläge i tre minuter ställs den automatiskt i et
strömbesparande viloläge. 

Fortsätta uppspelning

När ett spår är pausat trycker du på  när du vill fortsätta uppspelningen. 

Music titl

Blinkar under uppspelning

02:15
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Stoppa uppspelning/stänga av

Skjut knappen audio/off till off. 

Välja ett spår att spela

Gå ett spår framåt

Tryck snabbt en gång på  medan ett spår spelas upp. Varje gång du 
 går uppspelningen till nästa spår och spårnumret ändras i displayen

Gå tillbaka till början av ett spår

När ett spår har spelats i över två sekunder kan du trycka en gång snabbt på . Uppsp
då tillbaka till början av spåret.

Gå ett spår bakåt

När ett spår har spelats i över två sekunder kan du trycka snabbt två gånger på . Upp
går då tillbaka till föregående spår och spårnumret ändras i displayen.
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la ett spår
an snabbspola framåt eller bakåt i ett spår.

Spola framåt i ett spår

Håll ner  medan ett spår spelas. När du håller ner  spolar du framåt igenom spåre
uppspelningen stängs av medan uppspelningstiden ökar. När du släpper  återupptas 
uppspelningen.

Spola bakåt i ett spår

Håll ner  medan ett spår spelas. När du håller ner  spolar du bakåt i spåret och up
stängs av medan uppspelningstiden minskar. När du släpper  återupptas uppspelning

ja uppspelningsalternativ

Spela alla spår en gång

Tryck på mode.  visas. Inom några sekunder trycker du på  eller  upp
gånger tills  visas. 

   26   2302:24   24   25

   24   2503:24   26   23

Play>>

Play-1
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Upprepa uppspelning av alla spår

Tryck på mode.  visas. Inom några sekunder tryck
eller  upprepade gånger tills  visas. 

Upprepa uppspelning av ett spår

Medan du lyssnar på det spår som du vill upprepa trycker du p
 visas. Inom några sekunder trycker du på  elle

upprepade gånger tills  visas. 

Spela alla spår i slumpvis ordning

Tryck på mode.  visas. Inom några sekunder tryck
eller  upprepade gånger tills  visas. 

de

Play>>

Rep-ALL

Play>>

Rep-1

Play>>

Random
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ja uppspelningston
finns fem olika toninställningar som förbättrar uppspelningen av din musik. Följan
llningar finns; Normal, Classic, Rock, Jazz och Custom. I inställningen Custom kan d
 och Treble (bas och diskant). För att få bästa ljud när du spelar din musik ska du v
llning som passar bäst för den typ av musik du spelar.

Välja en toninställning

Tryck två gånger på mode medan ett spår spelas upp eller är p
 visas. Inom några sekunder trycker du på  elle

upprepade gånger för att välja den toninställning du vill använ
, , ,  eller 

Den valda toninställningen tillämpas på musiken.

Välja en egen toninställning

Tryck två gånger på mode medan ett spår spelas upp eller är p
 visas. Inom några sekunder trycker du på  elle

upprepade gånger för att välja . Inom några sekund
på mode igen. Displayen ändras till  eller 
några sekunder trycker du på  eller  upprepade gånger f
mellan  eller .

de

Tone>>

Normal Classic Rock Jazz C

Tone>>

Custom

Treble Bass

Treble Bass
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Justera Bass och Treble

Medan  eller  visas trycker du på mode och seda
volymknappen uppåt + eller nedåt – för att justera Bass eller Treble (bas e

Bass

Treble

-
+

Normal

Tone >>

Treble

Bass

Classic

Rock

Jazz

Custom

mode (2x)

mode mode

mode B

T

mode

Treble Bass

B

T
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pplås
a låser knapparna på Nokia Music Player så att du inte trycker på dem av misstag (
spelaren i fickan). 

Låsa knapparna

När du har justerat Nokia Music Player som du vill ha den skj
pilens riktning.  visas. Alla knapparna låses. 

Obs: Du kan fortfarande svara på telefonen och ringa
medan du är ansluten till en Nokia-mobiltelefon
att trycka på .

Om du ställer Nokia Music Player i viloläge och
låser knapparna kan du återuppta uppspelning g
trycka på .

Låsa upp knapparna

När du vill låsa upp knapparna skjuter du hold i pilens riktning
låses upp.

d

HOLD

d
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playljus
layen lyser i flera sekunder varje gång du trycker på någon av knapparna på Nokia
er. Om du vill tända displayljuset trycker du ner . Displayen lyser upp. När du 
ks displayljuset.
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 också använda Nokia Music Player för att ta emot FM-radiosändningar i stereo
sna på FM-radiosändningar måste du sätta i batteriet i Nokia Music Player och 
sladden. Om du inte har gjort detta ännu kan du gå till Nokia Music Player – Kom
bs: Hörlurssladden fungerar som antenn för FM-radion. Om du vill koppla o

använda en annan hörlurssladd ska du se till att den har samma längd som
ursprungliga sladden.

Slå på musikspelaren

Skjut knappen audio/off till audio. 

Välja uppspelning från FM-radion

Om musikspelaren användes senast för uppspelning från FM-radion visas
displayen:

Om musikspelaren användes senast för uppspelning från minneskortet vi
displayen:

MusicOn V  1.00 FM

MusicOn V  1.00 Digital
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När du vill växla från minneskort till FM-radio håller du  ner knappen 
sekunder tills  visas. Frekvensen för den senast valda FM-r
visas. Om vald frekvens är en sändande FM-station kan du höra sändn

Justera volymen

Tryck volymknappen uppåt + eller nedåt – när du vill justera volymen.

Minimum

Maximum

Obs: Volymnivån sparas på Nokia Music Player. När uppspelningen återupptas
volymen till den senaste inställningen.

e

FM

 FM 99.9

-
+
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ja en frekvens

Välja en högre frekvens

Tryck en gång på . Frekvensen ökas med 100 Hz. 
Tryck på  upprepade gånger med snabba tryck tills du kommer till önskad frekvens.

Välja en lägre frekvens

Tryck en gång på . Frekvensen minskar med 100 Hz. 
Tryck på  upprepade gånger med snabba tryck tills du kommer till önskad frekvens.

FM 100.0 FM 100.1

FM 100.0FM 100.1
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ända automatisk sökning av FM-frekvenser
an använda Nokia Music Player för att automatiskt söka efter en FM-stereosändni
cklig styrka för bra mottagning.

Söka automatiskt efter en högre frekvens

Håll ner . Frekvensen ändras när den automatiska sökningen börjar. Släpp . Nok
Player söker automatiskt tills en stereosändning hittas som har tillräcklig styrka för bra 
Frekvensen visas i displayen medan den ökas. När en passande station hittas stannar fre

Söka automatiskt efter en lägre frekvens

Håll ner . Frekvensen ändras när den automatiska sökningen börjar. Släpp . Nok
Player söker automatiskt tills en stereosändning hittas som har tillräcklig styrka för bra 
Frekvensen visas i displayen medan den minskas. När en passande station hittas stanna

    1    1FM 110.2    3    3

    3    3FM 115.2    1    1
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ända förinställda stationer
an ställa in fem favoritstationer så att du snabbt kan komma åt dem.

Välja en frekvens

När du har ställt in en station trycker du två gånger på mode. 
visas och efter två sekunder visas . 

Tilldela en kanal

Medan  visas trycker du på  eller  för att till
mellan CH1 och CH5.  

När du har valt en kanal mellan CH1 och CH5 trycker du på mo
 visas. Den valda frekvensen sparas.

de

Select

Select

Select Select

Yes
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Välja en förinställd frekvens

Tryck på . Med varje tryck på  visas kanalerna med de frekvenser som lagrats

Den kanal och frekvens som du vill lyssna på visas. Efter två sekunder kan du höra vald

la mellan stereo och mono

nd kan radiostörningar eller svaga signaler göra att du får brus i mottagningen. Om 
o kanske bruset slutar.

Välja mono

Medan du lyssnar på radion trycker du snabbt en gång på mode. Aktuell stereo- eller m
visas. Tryck på  eller  för att visa . Uppspelningen görs i mono.

Välja stereo

Medan du lyssnar på radion trycker du snabbt en gång på mode. Aktuell stereo- eller m
visas. Tryck på  eller  för att visa . Uppspelningen görs i stereo.

FM 100.0FM  99.1

Mono

Stereo
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kia Music Player är ansluten till din Nokia-telefon kan du använda handsfree-v
sna på musik och när det kommer ett inkommande samtal kan du svara och tala
ger utan att röra mobiltelefonen. Du kan också ringa ett samtal utan att röra mo
att använda röstuppringning.

bs: Röstuppringning är tillgängligt med Nokia-telefonerna 3310, 3330, 8250
8890.

telefoner kan användas?
jande Nokia-mobiltelefoner har utformats att fungera med Nokia Music Player. Förs
luta Nokia Music Player till någon annan telefon.

okia 8210 Nokia 3310, 3330 Nokia 8850, 8890 Nokia 82
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luta Nokia Music Player till telefonen

Ta bort locket till telefon/dator-kontakten

Bänd upp locket till telefon/dator-kontakten. Du kan ta bort lo
telefon/dator-kontakten men det sitter kvar på Nokia Music Pl

Obs: Locket är fastsatt på Nokia Music Player. Försök
bort det.

För att undvika att damm, smuts eller fukt komm
telefon/dator-kontakten på Nokia Music Player s
alltid sätta tillbaka locket när du inte använder s

Ansluta Nokia Music Player

Koppla in telefonsladden i telefon/dator-kontakten. Se till att p
rätt riktade. 

Obs: Var alltid försiktig när du kopplar in eller ur slad
tag i den tjockare delen av sladden, strax ovanfö
metallkontakten. Koppla aldrig in eller ur sladde
att hålla eller dra i själva sladden.

�����

�
����
��
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Ansluta till mobiltelefonen

Koppla in telefonsladden i uttaget på din Nokia-mobiltelefon. Uttagets placering kan va
beroende på vilken telefonmodell du har.

* Obs: Var försiktig så att du inte repar kontakten på telefonsladden när du öppn
stänger skalet på telefonen.

Nokia 8210 Nokia 3310, 3330

Nokia 8850*, 8890* Nokia 8250
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mot och ringa samtal
Nokia Music Player och Nokia-mobiltelefonen är anslutna kan du ta emot och ring
 handsfree-växling. När du får ett samtal medan du lyssnar på musik, ringer telefo
urarna och musiken stängs av. Musiken stängs också av automatiskt när du börjar r
tal. Nokia Music Player är också utrustad med en mikrofon så att du kan tala utan 
onen.

Obs: Röstuppringning är tillgängligt med Nokia-
mobiltelefonerna  3310, 3330, 8250 och 8890.

Om mikrofonen på Nokia Music Player är för lå
munnen kan den fånga upp oljud från omgivnin
Bästa röstresultat får du om du placerar Nokia M
Player inom 15 cm från munnen.

Om Nokia Music Player är avstängd kan du fort
ringa eller ta emot samtal med Nokia-mobiltelef
men då kommer ljudet bara från den vänstra hö

Om batteriet är nästan urladdat eller slut måste N
Music Player vara avstängd för att du ska kunna
eller ta emot samtal.

15 cm
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mot ett samtal

Ta emot ett samtal

Om telefonen ringer medan du lyssnar på musik hörs en ringsignal i hörlurarna. 
Tryck på  i en sekund. Musiken stängs av och om du lyssnar på musik från ett minnes
uppspelningen. Börja tala i normal ton. Du hör rösten på den som ringer i hörlurarna.

Avsluta ett samtal

När du är färdig med samtalet trycker du på  igen i en sekund. Telefonsamtalet avsluta
uppspelningen fortsätter.

Obs: För att få så lång lyssningstid som möjligt med ett batteri ska du stänga a
Music Player när du inte lyssnar på musik. Du kan fortfarande lyssna och
genom hörlurarna och mikrofonen när musikspelaren är avstängd.

ga ett samtal

är mycket enkelt att ringa ett samtal, även om du har din Nokia-mobiltelefon i ficka
sfree-växling och röstuppringning kan du ringa ett samtal utan att röra telefonen. 

rmation om röstuppringning finns i handboken som medföljer Nokia-mobiltelefon

Obs: Röstuppringning med Nokia Music Player kan hanteras på Nokia-telefone
och 8890.

Phone
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Aktivera telefonen

Håll ner  i en sekund. Musiken stängs av och om du lyssnar på musik från ett minnesk
uppspelningen. Du hör en röststartton i hörlurarna.  visas. 

Röstuppringning

Tala in namnet på numret som är inspelat på Nokia-mobiltelefonen. Namnet känns igen
upp i hörlurarna och efter en kort stund rings numret upp. Tala i normal ton när persone
ringer upp svarar.

Obs: Om inte telefonen känner igen namnet hör du en felton i hörlurarna. Börja
från Aktivera telefonen ovan.
Mer information om röstuppringning finns i användarhandboken för telef

Avsluta ett samtal

När du är färdig med samtalet trycker du på  igen. Telefonsamtalet avslutas och uppsp
fortsätter.

Phone
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ns olika sätt att svara och avsluta samtal på när du är ansluten till en Nokia-mob
etoderna förklaras nedan. Se i användarhandboken du fick med din Nokia-mob
a instruktioner om hur du använder telefonen.

ot samtal
ot ett samtal Avsluta ett samtal Resultat

k på Tryck på Detta är den metod som rekommenderas när du anv
handsfree-växling. När du trycker på  för att ta em
stängs musiken av. Om du spelar upp från minnesk
musiken.

k på Tryck på End(Avsluta) När du trycker på  för att ta emot samtalet, stängs
Om du spelar upp från minneskortet pausas musike
trycker på End(Avsluta) avslutas samtalet och inom
sekunder startas uppspelningen igen från låg volym
tills den når den volyminställning som gällde när sa

k på Answer(Svara) Tryck på När du trycker på Answer(Svara) kan du höra perso
men uppspelningen av musiken fortsätter och bland
personens röst. Detta kallas för musiksamtal. När d
avslutas samtalet och musiken fortsätter.

k på Answer Tryck på End När du trycker på Answer kan du höra personen som
uppspelningen av musiken fortsätter och blandas m
röst. Detta kallas för musiksamtal. När du trycker p
samtalet och musiken fortsätter.
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ga samtal

mot SMS-meddelanden

Sända SMS-meddelanden

inga ett samtal Avsluta ett samtal Resultat

ryck på Call(Ring) Tryck på End När du trycker på Call(Ring) rings numret upp och 
personen du ringer till, men uppspelningen av mus
och blandas med personens röst. Detta kallas för m
du trycker på End avslutas samtalet och musiken fo

ryck på Call Tryck på När du trycker på Call rings numret upp och du kop
personen du ringer till, men uppspelningen av mus
och blandas med personens röst. Detta kallas för m
du trycker på  avslutas samtalet och musiken stop
en gång till när du vill börja lyssna på musiken igen

Resultat

ryck på Read(Läs) Den valda ankomsttonen för SMS-meddelanden sp
hörlurarna. Använd Nokia-mobiltelefonen som van
emot och visa ett SMS-meddelande. 

Resultat

ryck på Send(Sänd) Du använder Nokia-mobiltelefonen som vanligt för
sända ett SMS-meddelande, men du får inget ljud i
du trycker på knapparna.
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tuppringning

Andra Nokia-mobiltelefoner som kan hantera röstuppringning

östuppringning Avsluta ett samtal Resultat

ryck på  och håll ner Tryck på Håll ner  i några sekunder. Musiken stängs av. Om
musik från ett minneskort pausas uppspelningen. D
röststartton i hörlurarna.  visas. 

Tala in namnet på numret som är inspelat på Nokia-
Namnet känns igen och spelas upp i hörlurarna och
stund rings numret upp. Tala i normal ton när perso
ringer upp svarar.

När du är färdig med samtalet trycker du på  igen
Telefonsamtalet avslutas och uppspelningen fortsät

ktivera röstuppringning Tryck på End Du måste stänga av Nokia Music Player innan du a
röstuppringning. Se i användarhandboken för Noki
mobiltelefonen. När samtalet är över kan du slå på 
Player igen. 

östuppringning Avsluta ett samtal Resultat

ktivera röstuppringning Tryck på End Du måste stänga av Nokia Music Player innan du a
röstuppringning. Se i användarhandboken för Noki
mobiltelefonen. När samtalet är över kan du slå på 
Player igen. 

Phone
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yminställningar och musiksamtal

Volyminställningar på Nokia-mobiltelefonen och Nokia Music Player

När du besvarar eller ringer ett musiksamtal har rösten på personen du talar med och m
volym som har ställts in på Nokia-mobiltelefonen. Om du använder volymkontrollen på
Player för att justera volymen under ett samtal, ändras volymen för både musik och rös
om det är svårt att höra rösten på den som ringer:

1. Sänk volymen genom att använda kontrollerna på Nokia Music Player.

2. Höj röstvolymen med hjälp av volymkontrollen på Nokia-mobiltelefonen.

Det rekommenderas att du ställer in volymen på Nokia-mobiltelefonen på en låg nivå. N
får ett samtal kan du sänka volymen på Nokia Music Player. Både volymen på Nokia M
och Nokia-mobiltelefonen sänks. Höj sedan volymen på Nokia-mobiltelefonen så att du
den som ringer bättre.
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dan Nokia Music Player är påslagen visas batteriets styrka i displayens strömindikat

 batteriet är fulladdat visas fem strömstaplar. När batteriet blir svagare, visas allt fär
mstaplar.

 strömindikatorn inte har några staplar alls, har du ca fem minuters samtalstid kvar. 
elt urladdat visas LOW BATTERY och Nokia Music Player stängs av. Det går inte att
sic Player igen förrän batteriet har bytts ut. Mer information om hur du byter batteri
allera batteriet.

BATTERYLOW
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mbesparingstips
• Under normal användning ger ett alkaliskt AAA-batteri tillräckligt med ström för att

från minneskortet i ca fem timmar.
• När det används i kallt klimat är batteriets livslängd betydligt kortare. Håll spelaren s

på ett varmt ställe.
• Om du lämnar batteriet i värme eller kyla, t.ex. i en stängd bil på sommaren eller i 

vinterförhållanden, minskar batteriets kapacitet och livslängd. Försök att alltid förvar
en temperatur mellan 15°C och 25°C (59°F och 77°F). Om du använder ett för varmt 
batteri med Nokia Music Player kanske inte enheten fungerar även om batteriet är fu

• Även om du kan lyssna på musik medan du talar i en ansluten Nokia-mobiltelefon kan
att spara på batteriet genom att stänga av Nokia Music Player under längre telefonsam
Handsfree-växling.

• Välj alltid batterier av god kvalitet och från välkända tillverkare för din Nokia Music
• Alkaliska batterier rekommenderas för lång livslängd. NiMH-batterier kan också anvä

inte använda batterier som identifieras som Ni-Cad-, mangan-, mangandioxid- eller li



 Mobile Phones.
Med ensamrätt.

?
enheten. Du 
älja View > 

r: "Some of 
för 

 filtyper 
 Options > 

 program på 
anager.

 with portable 

 att spelaren är 

en > USB-
et är Nokia 
 vad som står 
d i listan 
torn.
100

���

Fråga
Svar:

Fråga

Svar:

Fråga

Svar:
© 2001 Nokia

�	���
����	�	������0����

��	�
��

: Jag får ett felmeddelande när jag försöker läsa in en cd-skiva. Vad betyder det
Detta betyder att det har uppstått ett fel under kopieringen av data från cd-rom
kan låta Nokia Audio Manager identifiera den bästa inställningen genom att v
Options> ReadCD och klicka på knappen Configure it for me. 

: När jag först startar Nokia Audio Manager får jag ett felmeddelande som säge
this program’s file types are no longer associated with it." Vad betyder det? Var
återkommer detta felmeddelande?
Nokia Audio Manager kan hantera flera olika filtyper. Du kan välja att få olika
öppnade automatiskt så att de kan köras i Nokia Audio Manager. Gå till View >
File Types och markera de filer som du vill köra i Nokia Audio Manager.
Om du fortsätter att få detta meddelande kan det bero på att det finns ett annat
datorn som tar över associeringen av dessa filer när du avslutar Nokia Audio M

: När jag klickar på copy to device, får jag meddelandet Unable to communicate
device. Vad ska jag göra?
Det finns flera saker som du måste kontrollera om du får detta meddelande:

• Kontrollera att batteriet i Nokia Music Player inte är urladdat. Se Batteri.

• Kontrollera att Nokia Music Player är ordentligt ansluten med medföljande kabel och
påslagen. Se Ansluta till en dator. 

• På datorns skrivbord, välj Den här datorn > Kontrollpanelen > System > Enhetshanterar
styrenhet och kontrollera om Nokia Music Player finns med i listan. Det listade namn
Music Player HDR-1 Nokia Mobile Phones Ltd. Dubbelklicka på enheten och kontrollera
under Enhetsstatus. Enheten bör ha status Enheten fungerar. Om enheten inte finns me
skjuter du knappen audio/off till off och sedan tillbaka till audio och/eller startar om da
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Filtyp
Här
pro
Pla

.721

.asf *

.asx *

.avi *

.bmr

.bmo

.bmt

.cda

.lse

.mp3

.mpg

.m3u
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er som kan spelas med Nokia Audio Manager
 följer några av de filtyper som kan hanteras med Nokia Audio Manager beroende p
graminstick som är tillgängliga. Observera att inte alla filformat kan användas på No
yer.

* Windows Media Player måste vara installerat. 
† Real Player måste vara installerat. 
‡ InterRights Point måste vara installerat.
§ QuickTime måste vara installerat. 

Filer som kan hämtas till Nokia Music Player.

G.721-ljudfiler
MS-mediapelningslista
MS-mediapelningslista
Microsoft-film
Universal Music Group-
referensfiler
Universal Music Group-
erbjudandefiler
Universal Music Group-
innehållsfiler
Cd-ljudfiler
Nokia LSE DRM 
MPEG-ljudfiler 
MS-filmfil
Spelningslistefil

.mov § Quicktime-film

.pls PLS-spelningslista

.ra † RealAudio-filer

.ram † RealAudio-stream

.saf ‡ DigiBox-ljudfiler

.sm3 Säkra ljudfiler

.smil RA SMIL-filer

.wav Wave-ljudfiler

.wax * MS-mediapelningslista

.wm * MS-mediapelningslista

.wma Microsoft Windows M
ljudfiler

.wmv * MS-mediapelningslista

.wmx * MS-mediapelningslista

.wvx * MS-mediapelningslista
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: Varför visas ett felmeddelande när jag trycker på stängningsknappen?
Detta meddelande visas när du klickar på  i programmets namnlist när en cd
in. För att skydda cd-läsaren ska du använda knappen  i stället.

: Varför visas felmeddelandet Could not copy file när jag försöker kopiera, ändra
eller läsa en fil?
Den mest troliga orsaken att en fil inte kan kopieras eller läsas är att den redan 
du har en annan musikenhet öppen på datorn ska du stänga den enheten innan 
Det går heller inte att kopiera, ändra namn på eller läsa en fil om den inte är en
om den är skriven i ett format som inte är kompatibelt med Nokia Music Playe

: Vad betyder felmeddelandet Device not attached?
Nokia CD Manager kan inte identifiera din enhet. Kontrollera följande:

• Är enheten ansluten till datorn? Se Ansluta till en dator.

• Är USB-kabeln ordentligt inkopplad i både enheten och datorn?

: Vad betyder felmeddelandet Free Space?
Det finns inte tillräckligt med ledigt utrymme på minneskortet i Nokia Music 
slutföra åtgärden. Använd alternativet Delete Tracks i fönstret Media on Device 
filer från minneskortet i Nokia Music Player.

: Vad betyder felmeddelandet Load an audio CD?
Sätt i en cd-skiva i cd-romenheten och försök igen. Nokia CD Manager kan in
någon cd-skiva i cd-romenheten. Kontrollera följande:

• Är cd-skivan du försöker spela upp en ljud-cd?

• Är cd-romenheten stängd?

• Används cd-romenheten?
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: Unsupported Audio visas på min Nokia Music Player.
Du försöker att spela ett filformat som inte kan hanteras av Nokia Music Playe
WMA-bild eller något annat inkompatibelt format.

: Unusable Media visas på min Nokia Music Player.
Minneskortet i Nokia Music Player kan inte hanteras. Sätt i originalkortet elle
kompatibelt minneskort. Se Minneskort.

: Unknown Format visas på min Nokia Music Player.
Information om minneskortet har spelats in i ett filformat som inte kan hanteras
att spela musiken. Formatera om minneskortet med Nokia Audio Manager om
använda det med Nokia Music Player.

: Read Error visas på min Nokia Music Player.
Minneskortet kanske är skadat eller så finns det inte någon konstant strömförsö
nya batterier. Om Read Error visas igen tar du ur minneskortet och byter ut det

: Data Error visas på min Nokia Music Player.
Det valda spåret är skadat och kan inte spelas. Tryck på  eller  för att gå
spår.

: DRM Error visas på min Nokia Music Player.
Det finns ett problem med hanteringen av digitala rättigheter för valt spår och 
spelas. Tryck på  eller  för att gå till ett annat spår.

: No Media visas på min Nokia Music Player.
Minneskortet är inte isatt eller är felaktigt isatt. Sätt i ett minneskort eller kont
är ordentligt isatt. Se Sätta i minneskortet.
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åga: Format Error visas på min Nokia Music Player.
ar: Detta fel kan visas när du formaterar ett minneskort med Nokia Audio Manag

formatera minneskortet igen med Nokia Audio Manager. När Format Error inte
är felet korrigerat.

åga: No Track visas på min Nokia Music Player.
ar: Inget musikspår har spelats in på minneskortet. Kopiera musikspår med Nokia

Manager eller CD Manager. Se Överföra musik till minneskortet (med Nokia A
Manager) eller Kopiera till spelaren och lyssna på musik (med Nokia CD Mana

åga: Connect Error visas på min Nokia Music Player.
ar: Nokia Music Player är inte ordentligt ansluten till datorn med USB-kabeln ell

minneskortet matats ut medan Nokia Music Player var ansluten till datorn. Sät
minneskortet. Se Sätt i minneskortet. Stäng av Nokia Music Player och anslut d
igen. Se Ansluta till en dator.
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 Music Player 
ar inte.

Hold är aktiverat. Stäng av Hold.

Minneskortet är inte 
ordentligt isatt.

Kontrollera 
minneskortet.

Batteriet är urladdat. Byt ut batteriet.

Ansluten till datorn. Koppla från datorn.

rs ingenting. Volymen är för låg. Justera volymen.

Hörlurssladden är inte 
ordentligt ansluten.

Kontrollera 
anslutningen.

Kontakten är smutsig. Rengör och koppla i
igen.

ns brus. Hörlurarna eller telefon/
dator-sladden är virad 
runt spelaren.

Red ut sladden.
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blem Trolig orsak Lösning

sonen som ringer kan 
 höra min röst.

Du har mikrofonen för 
långt från munnen.

Mikrofonen ska vara
inom 15 cm från 
munnen.

Bakgrundsljudet är för 
högt.

Gå till en tystare pla

ddelandet "Can’t find 
ortable device" visas.

Minneskortet är inte 
ordentligt isatt.

Sätt i minneskortet 
ordentligt.

Nokia Music Player är 
inte påslagen.

Slå på spelaren.

USB-kabeln är inte 
ordentligt ansluten.

Kontrollera 
anslutningen.

t går inte att stänga 
kan till minneskortet.

Minneskortet är inte 
ordentligt isatt.

Sätt i minneskortet 
ordentligt.

Minneskortet är av fel 
typ.

Kontrollera att 
minneskortet har sam
storlek som det 
ursprungliga 
minneskortet.
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blem Trolig orsak Lösning

stuppringning 
gerar inte

Din telefon kan inte 
hantera röstuppringning 
när den är ansluten till 
Nokia Music Player.

Röstuppringning kan
bara hanteras på No
mobiltelefonerna 33
och 8890.

Din Nokia-mobiltelefon 
är inte rätt inställd för 
röstuppringning.

Se instruktionerna s
medföljer Nokia-
mobiltelefonen.

Nokia Music Player är 
inte ordentligt ansluten 
till Nokia-
mobiltelefonen.

Kontrollera 
anslutningen.
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usic Player

usic Player är en tekniskt avancerad produkt 
ld med stor yrkesskicklighet och bör behandlas 
sta omsorg. Om du följer nedanstående råd 
 du att kunna uppfylla kraven för att garantin 
la och ha nytta av produkten i många år. När du 
r Nokia Music Player:
ra alla små delar utom räckhåll för barn.
a den mot fukt. Nederbörd, fukt och vätskor 

åller ämnen som kan fräta på de elektroniska 
rna.
ik att använda eller förvara den i dammiga och 
iga miljöer. Rörliga delar kan ta skada.
ra den inte på varma platser. Höga temperaturer 
rkorta livslängden för elektroniska apparater, 

 batterierna och kan smälta vissa plaster.
ra den inte på kalla platser. När musikspelaren 
 upp (till sin normala temperatur) kan det bildas 
å insidan av den, vilket kan skada de 
oniska kretsarna.
k inte öppna den. Okunnig hantering kan skada 

, skaka eller slå inte på den. Om den behandlas 
kan kretskorten gå sönder.
nd inte starka kemikalier, lösningsmedel eller 
de/starka rengöringsmedel för att rengöra den. 
 av den med en mjuk trasa som fuktats med en 
vållösning.

• Måla den inte. Målarfärg kan täppa till
delar och hindra normal användning.

• Använd bara de kablar och tillbehör so
spelaren. Obehörig ändring eller fel til
skada musikspelaren eller ge sämre pr

• Om Nokia Music Player, dess delar ell
fungerar ordentligt ska du ta dem till n
kvalificerade serviceverkstad. Persona
hjälpa dig och se till att den lagas om s

Minneskort
• När du köper ett nytt multimediakort (

fästa medföljande etikett på angiven p
Fäst inte något annat på kortet. Skriv p
innan du fäster den på kortet. Om du b
något på etiketten efter att den har fäst
du använda en filtpenna (oljebaserad).
blyertspenna eller kulspetspenna. 

• Använd bara multimediakort (MMC) i
Player. 

• Om du vill byta ut minneskortet ska du
som har samma storlek som det som m
enhet. Ta med dig det ursprungliga mi
butiken och kontrollera att det nya kor

etikett
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k. Alla kort som har samma storlek fungerar med Nokia Music Player.

ra alla minneskort utom räckhåll för barn.
eskortet och dess kontakter kan lätt skadas av 
eller om det böjs så var försiktig när du 
rar, sätter in eller tar ut kortet.
a alltid se till att Nokia Music Player är 
gd innan du installerar minneskortet.

nd eller lagra inte minneskortet i för höga 
raturer, i direkt solljus eller där det är hög 
ktighet. Undvik miljöer som kan skapa 
nsering på kortet.
t ska hållas ifrån frätande material.
ik att vidröra de elektriska kontakterna.
te i minneskortet i någon annan enhet, t. ex. en 

l kamera, eftersom detta kan skada kortet eller 
ationen som finns på det.

 Music Player används med ett AAA-batteri. 
k inte använda batterier av andra storlekar.
 av Nokia Music Player innan du öppnar 
ifacket och byter ut batteriet.
n använda uppladdningsbara batterier i Nokia 
 Player. Innan du laddar om ett batteri ska du 

era att batteriet verkligen är utformat för att 
s om och att du använder rätt enhet för laddning.
u lämnar batteriet i värme eller kyla, t.ex. i en 
 bil på sommaren eller i vinterförhållanden, 
ar batteriets kapacitet och livslängd. Försök att 
förvara batteriet i en temperatur mellan 15°C 

och 25°C (59°F och 77°F). Om du anv
varmt eller för kallt batteri med Nokia
kanske inte enheten fungerar även om 
fulladdat.

• Batterier måste återvinnas eller tillvara
Kasta aldrig batterier i hushållssoporn
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bs: *Ljudkort är inte ett krav, men utan ljudkort går det inte att spela musik med Nokia Audio Manager på
†Cd-romenhetens hastighet kan påverka kodningskvaliteten

ekt Krav
r IBM PC/AT-kompatibel.

essor Pentium MMX 266 MHz krävs. Pentium 300 MHz rekommender

ne Minst 48 MB rekommenderas. 64 MB föreslås för Windows 2000

ddisk 35 MB ledigt diskutrymme krävs för att installera programvaran. 
ytterligare utrymme för dina musikfiler.

rativsystem Windows 98/Windows ME/Windows 2000. Denna programvara k
användas på en dator som kör Windows 95/3.1 eller Windows NT
inte programvaran hanteras på en hemmagjord dator som har Win
installerat och/eller en dator vars system har uppgraderats från W
till Windows 98.

skärm Mer än 800 x 600 bildpunkter (pixel). Mer än 65 536 färger, instä
Color.

bläsare Microsoft Internet Explorer eller Netscape Navigator, version 4.0

ortfilformat som kan hanteras ACC, MP3, WAV, CD-DA (musik-cd)

Version 1.0/1.1 eller högre.

romenhet† SCSI/ANSI X3T10-1048D-standard. ATAPI/SFF-8020i-standard

ommenderat ljudkort* Sound Blaster 16 (rekommenderas)



�"

111  Mobile Phones.
Med ensamrätt.

Min

kort ska du 
å grund av 
r ut på 
������	������

© 2001 Nokia

neskort

Köpa ett nytt kort

Alla multimediakort (MMC) ska fungera. Om du vill köpa ett nytt eller ett extra minnes
jämföra det nya kortet med det du redan har och kontrollera att det har samma storlek. P
den snabba utvecklingen med nya kort och standarder kanske inte alla kort som komme
marknaden i framtiden passar i din Nokia Music Player. 

Välja storlek på minneskortet

Både kort på 32MB och 64MB kan hanteras.
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ommenderad kodningsbithastighet
Nokia Music Player är särskilt utformad att ge 64 minuter musik på ett 32MB-minneks
kodat med AAC.

Om du vill ställa in kodningsbithastigheten på Nokia Music Player väljer du View > Opt
CD > Bit Rate i Nokia Audio Manager.

* Obs: Bäst = Professionell kvalitet

Bättre = Cd-kvalitet

Bra = Nästan cd-kvalitet

Musikkvalitet Kapacitet på ett 
32MB-kort (minuter)

Re
kBit/s MP3 AAC

128 Bra *Bäst 32 1
96 OK *Bättre 48
64 Dålig *Bra 64
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udio Manager V1.0 och Nokia CD Manager är standardsystem som levereras 
kia Music Player.

e slutanvändaren besöker club.nokia.com och registrerar sitt Nokia Music Play
mmer under installationen och på Club Nokias webbplats, kommer det att finna
radera med nya funktioner för Nokia Audio Manager, Nokia CD Manager och N

 Det kan också finnas andra filer att hämta.

http://www.club.nokia.com/
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 funktion för fast programvara
usic Player är utformad så att det är enkelt att uppgradera den fasta programva

are). Med uppgraderingar av den fasta programvaran får du:
tkomst till förbättringar i prestanda för enhetens programvara
tkomst till funktioner som läggs till efter inköpet

bs: Du behöver en aktiv Internet-anslutning för att hämta uppgraderingar av 
programvaran från Internet.

cering av fast programvara

 befintliga fasta programvaran finns i följande katalog:
en här datorn\Nokia\Utilities\nmpv1sw.exe

pv1sw.exe är programfilen. Om du hämtar ny programvara från Internet måste du sp
alogen Utilities.

pgradera fast programvara
täng av Nokia Music Player genom att skjuta knappen audio/off till off. 

nslut Nokia Music Player till datorn. Se Ansluta till en dator. 
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• Tryck på  och   samtidigt och skjut knappen audio/off till audio.

• Firmware upgrade rullas över displayen på Nokia Music Player.

• Dubbelklicka på nmpv1sw.exe.
• Vänta i några sekunder. Programming the FLASH visas på datorn
• Update rullas över displayen på Nokia Music Player.

• Firmware upgrade Vänta i några sekunder, datorn visar Firmware has been upgraded s
• Nokia och MusicOn visas i displayen.
• Uppdateringen av den fasta programvaran är klar.

����� �� 	�
��


����
���

Firmware upgrade

Update
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AC står för Advanced Audio Coding (avancerad ljudkodning) och är ett kodningsf
 är utvecklat av Dolby, Franhaufer, AT&T och Sony. AAC är nästa generation efter M
ar mycket mindre utrymme på hårddisken eller minneskortet. 

ighet: Bithastigheten är i allmänhet samplingsfrekvensen multiplicerat med antalet "
pling". När musiken samplas, har amplituden eller volymen ett omfång som ska fång
ket lågt till ganska högt. Detta omfång måste uttryckas i digitala termer med bitar. E
eller av", vilket inte är särskilt högklassig ljudåtergivning. Åtta bitar ger 256 nivåer,
är dåligt för tal. Om du kommer upp i 24 bitar får du överväldigande 16 miljoner ni
et är mycket mer än vad som kan uppfattas av det mänskliga örat. Ta samplingsfrekv
det valda antalet bitar per sampling, multiplicera dem och stoppa ner dem i en sladd
n "bithastighet". I allmänhet kan man säga att ju högre bithastighet, desto bättre ljud
det i den resulterande filen.

ägg: Ett system som övervakar trafiken mellan ett företags nätverk och Internet i 
rhetssyfte. En brandvägg kan begränsa åtkomst och/eller vissa former av kommunik
an datorer i ett företag och de som finns på Internet.

litet: Filer med cd-kvalitet ger mycket bra ljudkvalitet. Filer med cd-kvalitet är de m
primerade av de digitala musikfilerna och tar upp mer utrymme på hårddisken. Om 
- eller MP3-format via View > Options > Read CD har du fem kvalitetsalternativ, frå

primeringsförhållande på 112kBit/s med 11.25 : 1 till 320kBit/s med 4.4 : 1. 

DRM står för Digital Rights Management (hantering av digitala rättigheter) och är e
 skyddar upphovsrätten på alla användarnivåer vilket medför att ägaren till innehålle
ka alla sina digitala rättigheter och hantera distribution, ersättning och betalning för
hållet.

ogramvara (firmware): Den programvara som gör att Nokia Music Player fungera
programvara för systemet.
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radiokvalitet: FM-radiokvalitet är den lägsta ljudkvaliteten. Dessa filer tar upp minst u
m du väljer AAC- eller MP3-format via View > Options > Read CD spelar du in med 64
ed en komprimering på 22.5 : 1.

re: En genre är en viss stil eller gruppering för artistiska kompositioner.

rnet-leverantör (ISP): ISP står för Internet Service Provider. Det företag som används
nsluta till Internet. 

: MP3 står för MPEG (Motion Picture Experts Group) Layer 3 och är ett särskilt forma
usikfiler. Filerna är små men håller hög ljudkvalitet. MP3-filer är ljudfiler som har 

omprimerats så att de tar upp mindre utrymme på hårddisken. Ett MP3-spår med storle
B motsvarar exempelvis inte mindre än 33 746 KB i .wav-format.

tan cd-kvalitet: Om du har begränsat utrymme på hårddisken är Nästan cd-kvalitet ett 
är du läser in en cd-skiva. Ljudkvaliteten ligger ganska nära cd-kvalitet men filerna är m
m du väljer AAC eller MP3 via View > Options > Read CD har du två alternativ för insp
ed Nästan cd-kvalitet. Dessa är 96kBit/s med komprimering på 15 : 1 eller 80kBit/s m

plingsfrekvens: Samplingsfrekvensen är hur ofta du tittar på eller "samplar" den varie
ignalen som vi kallar musik. 

gradering: Hämta den senaste versionen av fast programvara eller programvara.

A: WMA står för Windows Media Audio. 
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